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Introduction

This tutorial model of a comb-drive tuning fork gyroscope is kindly provided by Dr. James
Ransley at Veryst Engineering, LLC. The model demonstrates fully parameterized
geometry, extensive use of selection features, implementation of analytic formulas for the
electromechanical forces and response estimation, and comparison of numerical results
with analytical estimations. In particular, extrusion operators are used to compute the
distances between electrodes for force calculation. The device is loosely based on Ref. 1.

Model Definition

The geometry of the device is shown in the figure below. All dimensions and numbers of
etch holes and comb fingers are parameterized in the model. Various selection features are
used for the construction of the geometry and the setup of position-dependent variables,

physics, and mesh.

Figure 1: The geometry of the gyroscope.

The gyroscope is composed of two proof masses supported by springs anchored to the
substrate (not explicitly modeled). The comb drive excites the drive mode with the two
masses oscillating along the X-axis in opposite directions. The device is designed to sense
rotations around the Y-axis. The combination of such rotations and the drive-mode
motion causes a Coriolis force in the positive and negative Z directions, which excites the
out-of-plane sense-mode oscillation of the two masses. The sense-mode oscillation is

picked up capacitively with electrodes in the substrate.
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The combs are assumed to be DC-biased at 60 V and AC-excited at 3 V. The sense
clectrodes are assumed to be DC-biased at 5 V. While a predefined Electromechanics
multiphysics coupling is available with the MEMS Module, this model demonstrates the

use of analytic formulas for computing the electrostatic forces.

The implementation of the parallel plate capacitor forces in the model is based on the
expression for the force per unit area between two parallel plates of infinite extent with a

dielectric medium of relative permittivity 1 (air or vacuum) in between:

zaOV2
Fy=— (6))
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Here, g is the permittivity of free space and d is the distance between the plates. This work
uses this formula locally to approximate the forces between electrodes even when the
plates are slightly misaligned, or near the edges of a structure where fringing fields might
be important. These approximations make the model much more scalable and eliminate
the need to solve for the field explicitly. They can be improved by adding empirically tuned

fringing factors, determined by explicit calculations of the capacitance of the device.

The distance between the parallel plates can be determined using extrusion operators with
the mesh search method set to “closest point” in the advanced settings. The operators will
return the value of a given quantity at the closest point on the source surface, which is
chosen to be the opposite plate of the capacitor. To ensure that the Jacobian of the
operators is handled correctly, it is necessary to ensure that the dependent variables appear
explicitly within the extrusion operators, which is why the coordinates of the moving

surfaces are represented as X+u, and so on, in the expressions.

To understand the formulas added to implement the comb drive forces, consider the

equation for the total force on any electrostatic actuator by using the equation

- 1aCy2

F_26x

(2)
where C is the comb capacitance and x is the coordinate along the direction of travel of
the comb. For this example, assume that the comb travels parallel to the x-axis; more
sophisticated expressions can be employed to capture effects due to comb misalignment.
For motion along the x-axis with a displacement of u, the corresponding capacitance per
unit height of a comb face is given by

golt

C=CO+"'C'i'— (3)
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where Cj) is the comb capacitance at zero displacement. The force per unit length of each
vertical edge at the tip of the comb is therefore

2
ggV

2d

As in the case of the parallel plate capacitors, the fidelity of the model can be improved by
the calibration of fringing factors based on the accurate computation of the real

capacitance of the structure.

Also note that several other techniques were used in the creation of the model. The signs
of the forces are handled by assigning variables with different values to different edges or
surfaces of the geometry. COMSOL’s sophisticated perturbation machinery is used to
automatically add AC forces to the model by means of the 1inper () operator. The model
also uses a parameter AC_on to zero out the perturbation terms for stationary studies so
that they do not appear in a misleading fashion in the postprocessing of stationary

solutions.

To save time and file size, a relatively coarse mesh is used. Nevertheless, the mesh is
parameterized to be ready for refinement studies. In the follow-up model, Manufacturing
Variation Effects in a Micromachined Comb-Drive Tuning Fork Rate Gyroscope, the

Deformed Geometry feature will be used to study the effects of manufacturing variations,
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with the advantage that it keeps the same mesh while varying the geometry, thus avoiding

unwanted variations caused by a different mesh being used for a different geometry.

NN

Figure 2: The mesh used in the model.
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Results and Discussion

Figure 3 shows the stationary response of the device. The masses are pulled down slightly
by the bias voltage of the sense electrodes. The masses do not move horizontally since the
DC part of the comb drive forces for each mass are equal and in opposite directions so they

cancel out.

Volume: von Mises stress (N/m?)
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Figure 3: Stationary response of the device.
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Figure 4 and Figure 5 show the eigenfrequencies and mode shapes of the in-plane drive

mode and the out-of-plane sense mode, respectively.

Eigenfrequency=38262+38.262i Hz Surface: Displacement magnitude (um)

Figure 4: Drive mode shape.

Eigenfrequency=41125+41.498i Hz Surface: Displacement magnitude (um)

Figure 5: Sense mode shape.
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The drive-mode and sense-mode resonant frequencies can be estimated with analytic
formulas from standard textbooks (for example, Ref. 2). This can be done easily in a
Parameters table in the model, as detailed in the Modeling Instructions section. The

agreement between the numerical and analytic results is good; see Table 1.

TABLE I: NUMERICAL AND ANALYTIC RESULTS OF THE DRIVE-MODE AND SENSE-MODE FREQUENCIES.

Drive mode Sense mode
Numerical 38 kHz 4| kHz
Analytic 40 kHz 45 kHz

Figure 6 shows the drive-mode displacement under the simulated operation. The

amplitude can be read off from the color legend.
freq=38262 Hz, AC_on=1, Omega=100 deg/s Drive mode amplitude (um)

A 235

¥ -2.35

Figure 6: The drive mode displacement.
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Figure 7 shows the sense-mode displacement. Due to the tilt of the masses, the amplitude

is either read off the Evaluation 3D table after clicking around the centers of the masses,

or evaluated using an average operator, as detailed in the Modeling Instructions section.
freq=38262 Hz, AC_on=1, Omega=100 deg/s Sense mode amplitude (um)

A 336x10™
x107

3

-3

¥ -3.36x10™

Figure 7: The sense-mode displacement.

The drive-mode and sense-mode amplitudes are also estimated with analytic formulas. The

agreement between the numerical and analytic results is good; see Table 2.

TABLE 2: NUMERICAL AND ANALYTIC RESULTS OF THE DRIVE-MODE AND SENSE-MODE AMPLITUDES.

Drive mode Sense mode
Numerical 2.4 um 0.20 nm
Analytic 2.2 um 0.21 nm

Finally, the sensitivity in terms of the sense capacitance change per rotation rate, in the
units of aF /(deg/s), is computed using two alternative methods. Both give the same value
of 0.23 aF/(deg/s). The capacitance amplitude at the rotation rate of 100 deg/s is 23 aF.

Reference

1. J. Bernstein, S. Cho, A. T. King, A. Kourepenis, P. Maciel, and M. Weinberg, “A
micromachined comb-drive tuning fork rate gyroscope,” Proceedings IEEE Micro
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2. V. Kaajakari, Practical MEMS, Small Gear Pub. (Las Vegas, Nev.), 2009.

Application Library path: MEMS_Module/Sensors/
comb_drive_tuning_fork_gyroscope

Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click im 3p.

2 In the Select Physics tree, select Structural Mechanics>Solid Mechanics (solid).
3 Click Add.

4 Click e Study.

5 In the Select Study tree, select General Studies>Stationary.

6 Click [V] Done.

GEOMETRY |
The Model Wizard starts the COMSOL Desktop at the Geometry node. Take the

opportunity to set the length unit to microns for convenience.

I In the Model Builder window, under Component | (compl) click Geometry 1.
2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose pm.

Enter model parameters in separate Parameters nodes according to the purposes of the

parameters. First the ones for the geometry and mesh:

GLOBAL DEFINITIONS

Parameters | - Geometry & Mesh
I In the Model Builder window, under Global Definitions click Parameters I.
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2 In the Settings window for Parameters, type Parameters 1 - Geometry & Meshin the

Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description
1 mass 200[um] 2E-4 m Mass length
w_mass 1 mass 2E-4m Mass width
y_spring_l 350[um] 3.5E-4m Y spring length
y_spring_w 10[um] [E-5m Y spring width
etch_dim 10[um] IE-5m Etch hole
dimension
n_etch_x 8 8 Number of etch
holes, x
direction
n_etch_y 8 8 Number of etch
holes, y
direction
t_beam 12[um] 1.2E-5 m Structure layer
thickness
w_anchor 5[um] 5E-6 m Anchor width
tether_x 55[um] 5.5E-5m Tether beam x-
coordinate
x_spring_l 150[um] I.5E-4 m X spring length
X_spring_w 4[um] 4E-6 m X spring width
tether_1 120[um] |1.2E-4 m Tether beam
length
tether_w 8[um] 8E-6 m Tether beam width
w_stator_base 15[um] |.5E-5 m Stator base width
rotor_stator_ov 40[um] 4E-5m Rotor/stator
erlap overlap length
1 rotor 50[um] S5E-5m Rotor comb length
w_rotor 8[um] 8E-6 m Rotor comb width
n_combs 8 8 Number of combs
t_anchor 2[um] 2E-6 m Anchor layer
thickness
gap_combs 2[um] 2E-6 m Gap between combs

I | A MICROMACHINED COMB-DRIVE TUNING FORK RATE GYROSCOPE



Name Expression Value Description
rotor_spacing (w_mass-w_rotor* |.5|IIIE-5m Spacing between
n_combs) / rotor combs
(n_combs+1)
w_stator rotor_spacing-2* I.III1E-5m Stator comb width
gap_combs
electrode_ratio 0.9 0.9 Ratio for
dimension of
sense electrode
delta 0.01[um] IE-8 m Small distance
for selections
mesh_factor 1 | Mesh size factor

(larger is bigger
elements)

Then create a new Parameters node for the physics settings. Note the parameter AC_on will
be used to control the on/off of the AC driving voltage.

Parameters 2 - Physics
I In the Home toolbar, click Pi Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 2 - Physics in the Label text
field.

3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description

Vbase 5[V] 5V Potential difference between mass
and sense electrode

Vcomb 60[V] 60V Potential difference between comb
rotors and stators

Q 500 500 Resonator quality factor

V_ac 3[V] 3V AC Comb voltage

Omega O[deg/s] 0 rad/s Angular rotation rate

AC_on 0 0 1 to turn on AC drive, 0 otherwise

Create the geometry. Note how various Selection features are used to label collections of
geometric objects to make it easier to set up physics and mesh later. Note how Boolean
and Transform operations can inherit the Cumulative selection of their input objects. First

build the proof masses.
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GEOMETRY |

Work Plane | - Mass

I In the Geometry toolbar, click '{é,[s Work Plane.

2 In the Settings window for Work Plane, type Work Plane 1 - Mass in the Label text
field.

Work Plane | - Mass (wpl)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle | - Mass: +X
I In the Work Plane toolbar, click |:| Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - Mass: +Xin the Label text
field.

Locate the Size and Shape section. In the Width text field, type 1_mass.
In the Height text field, type w_mass.
Locate the Position section. From the Base list, choosc Center.

In the xw text field, type y_spring_1/2.

N o0 i1 AW

Locate the Selections of Resulting Entities scction. Find the Cumulative selection

subsection. Click New.
8 In the New Cumulative Selection dialog box, type Mass in the Name text field.
9 Click OK.
10 Right-click Rectangle I - Mass: +X and choose Duplicate.
Work Plane | - Mass (wpl)>Rectangle | - Mass: +X | (r2)

I In the Model Builder window, under Component | (compl)>Geometry |>Work Plane I -
Mass (wpl)>Plane Geometry click Rectangle I - Mass: +X | (r2).

2 In the Settings window for Rectangle, type Rectangle 2 - Footprint of sense
electrode in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type electrode_ratio*
1 _mass.

4 In the Height text field, type electrode_ratio*w_mass.

Point | - For mesh copy
I In the Work Plane toolbar, click * Point.

2 In the Settings window for Peint, type Point 1 - For mesh copy in the Label text field.
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3 Locate the Point section. In the xw text field, type y_spring_1/2-electrode_ratio*
1 mass/2.

4 In the yw text field, type electrode_ratio*w_mass/5.

5 Locate the Selections of Resulting Entities scction. Find the Cumulative selection
subsection. From the Contribute to list, choose Mass.

Work Plane | - Mass (wpl)>Rectangle 3 (r3)

I In the Work Plane toolbar, click |:| Rectangle.

In the Settings window for Rectangle, locate the Size and Shape section.

In the Width text field, type etch_dim.

In the Height text field, type etch_dim.

Locate the Position section. From the Base list, choose Center.

In the xw text field, type y_spring_1/2+w_mass/2-w_mass/(n_etch_x+1).

In the yw text field, type 1_mass/2-1_mass/(n_etch_x+1).

O N o0 U1 A W N

Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. Click New.
9 In the New Cumulative Selection dialog box, type Subtract in the Name text field.
10 Click OK.
Work Plane | - Mass (wpl)>Array_K I,(arrl)
I In the Work Plane toolbar, click /), Transforms and choose Array.
In the Settings window for Array, locate the Input section.
From the Input objects list, choose Subtract.
Locate the Size section. In the xw size text field, type n_etch_x.
In the yw size text field, type n_etch_y.

Locate the Displacement section. In the xw text field, type -w_mass/ (n_etch_x+1).

N o0 1 A WN

In the yw text field, type -1_mass/(n_etch_x+1).

Work Plane | - Mass (wp|)>Difference | (difl)

I In the Work Plane toolbar, click @ Booleans and Partitions and choosc Difference.
2 In the Settings window for Difference, locate the Difference section.

3 From the Objects to add list, choose Mass.

4 From the Objects to subtract list, choose Subtract.

Work Plane | - Mass (wpl)>Mirror | (mirl)
I In the Work Plane toolbar, click :4: Transforms and choose Mirror.
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2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Mass.

4 Seclect the Keep input objects check box.

Extrude | - Mass

I In the Model Builder window, right-click Geometry | and choose Extrude.

2 In the Settings window for Extrude, type Extrude 1 - Mass in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

Distances (um)

t_beam

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection
check box.

5 From the Show in physics list, choose All levels.

6 Click ™ Build Selected.

Then build the anchors.

Work Plane 2 - Anchors

I In the Geometry toolbar, click '{é,ls Work Plane.

2 In the Settings window for Work Plane, type Work Plane 2 - Anchors in the Label text

field.

Work Plane 2 - Anchors (wp2)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle | - Spring Anchor
I In the Work Plane toolbar, click || Rectangle.

2 In the Settings window for Rectangle, typec Rectangle 1 - Spring Anchor in the Label
text field.

Locate the Size and Shape section. In the Width text field, type w_anchor.
In the Height text field, type w_anchor.
Locate the Position section. From the Base list, choosc Center.

In the xw text field, type tether_x.

N O 1 AW

In the yw text field, type 1_mass/2+x_spring_l+y_spring_w/2-y_spring_w/2-
tether_l+w_anchor.
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8 Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. Click New.
9 In the New Cumulative Selection dialog box, type Anchors in the Name text field.
10 Click OK.
Il Right-click Rectangle | - Spring Anchor and choose Duplicate.
Work Plane 2 - Anchors (wp2)>Rectangle | - Spring Anchor | (r2)

I In the Model Builder window, under Component | (compl)>Geometry 1>Work Plane 2 -
Anchors (wp2)>Plane Geometry click Rectangle | - Spring Anchor 1 (r2).

2 In the Settings window for Rectangle, typec Rectangle 2 - Stator Anchor in the Label
text field.

3 Locate the Position section. In the xw text field, type y_spring_l/2+w_mass/2+
w_stator_base/2+2*1 rotor-rotor_stator overlap.

4 In the yw text field, type 1_mass/2-0.5*1_mass/(n_combs+1).
Work Plane 2 - Anchors (wp2)>Mirror | (mirl)

I In the Work Plane toolbar, click :4: Transforms and choose Mirror.
2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Anchors.

4 Select the Keep input objects check box.

Work Plane 2 - Anchors (wp2)>Rectangle 2 - Stator Anchor (r2)

In the Model Builder window, right-click Rectangle 2 - Stator Anchor (r2) and choose
Duplicate.

Work Plane 2 - Anchors (wp2)>Rectangle 2 - Stator Anchor | (r3)
I In the Model Builder window, under Component | (compl)>Geometry 1>Work Plane 2 -
Anchors (wp2)>Plane Geometry click Rectangle 2 - Stator Anchor | (¥3).

2 In the Settings window for Rectangle, type Rectangle 3 - Stator Anchor 2 in the
Label text field.

3 Locate the Pesition section. In the xw text field, type 0.

Work Plane 2 - Anchors (wp2)>Mirror 2 (mir2)

I In the Work Plane toolbar, click /), Transforms and choose Mirror.
2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Anchors.

4 Seclect the Keep input objects check box.
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5 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.

6 In the yw text field, type 1.

Extrude 2 - Anchors

I In the Model Builder window, right-click Geometry | and choose Extrude.

2 In the Settings window for Extrude, type Extrude 2 - Anchors in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

Distances (um)

t_anchor

4 Seclect the Reverse direction check box.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection
check box.

6 From the Show in physics list, choose All levels.

7 Click ] Build Selected.

Next build the springs.

Work Plane 3 - Springs

I In the Geometry toolbar, click '{é,ls Work Plane.

2 In the Settings window for Work Plane, type Work Plane 3 - Springs in the Label text

field.

Work Plane 3 - Springs (wp3)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle | - Y Spring: +Y
I In the Work Plane toolbar, click || Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - Y Spring: +Y in the Label
text field.

3 Locate the Size and Shape scction. In the Width text field, type y_spring_1+
X_spring_w.

In the Height text field, type y_spring_w.

Locate the Position section. From the Base list, choose Center.

In the yw text field, type 1_mass/2+x_spring_l+y_spring_w/2.

N o n1obh

Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. Click New.
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8 In the New Cumulative Selection dialog box, type Mirror Y in the Name text field.
9 Click OK.

Rectangle 2 - X Spring: +X +Y

I In the Work Plane toolbar, click |:| Rectangle.

2 In the Settings window for Rectangle, type Rectangle 2 - X Spring: +X +Y in the
Label text field.

Locate the Size and Shape section. In the Width text field, type x_spring_w.
In the Height text field, type x_spring_l+y_spring_w.

Locate the Position section. From the Base list, choose Center.

In the xw text field, type y_spring_1/2.

In the yw text field, type 1_mass/2+x_spring_l/2+y_spring_w/2.

O N o U1 AW

Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. Click New.
9 In the New Cumulative Selection dialog box, type Mirror XY in the Name text field.
10 Click OK.
Rectangle 3 - Tether: +X +Y
I In the Work Plane toolbar, click |:| Rectangle.

2 In the Settings window for Rectangle, type Rectangle 3 - Tether: +X +Y in the Label
text field.

Locate the Size and Shape section. In the Width text field, type tether_w.
In the Height text field, type tether_l+y_spring_w.

Locate the Position section. In the xw text field, type tether_x-tether_w/2.

o U1 AW

In the yw text field, type 1_mass/2+x_spring_l+y_spring_w/2-y_spring_w/2-
tether_1.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection
subsection. From the Contribute to list, choose Mirror XY.

Work Plane 3 - Springs (wp3)>MiiroE I (mirl)

I In the Work Plane toolbar, click /), Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Mirror XY.

4 Seclect the Keep input objects check box.

5 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.
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6 In the yw text field, type 1.

Work Plane 3 - Springs (wp3)>MiirO£ 2 (mir2)

I In the Work Plane toolbar, click /), Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Mirror XY.

4 Select the Keep input objects check box.

Work Plane 3 - Springs (wp3)>MiiroE 3 (mir3)

I In the Work Plane toolbar, click /), Transforms and choose Mirror.
In the Settings window for Mirror, locate the Input section.
From the Input objects list, choose Mirror Y.

2
3
4 Locate the Normal Vector to Line of Reflection section. In the xw text field, type 0.
5 In the yw text field, type 1.

6

Locate the Input section. Select the Keep input objects check box.
Extrude 3 - Springs
I In the Model Builder window, right-click Geometry | and choose Extrude.
2 In the Settings window for Extrude, type Extrude 3 - Springs in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

Distances (um)

t_beam

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection
check box.

5 From the Show in physics list, choose All levels.

6 Click ™ Build Selected.

Then build the rotor combs.

Work Plane 4 - Rotors

I In the Geometry toolbar, click '{é,ls Work Plane.

2 In the Settings window for Work Plane, type Work Plane 4 - Rotors in the Label text
field.

Work Plane 4 - Rotors (wp4)>Plane Geometry
In the Model Builder window, click Plane Geometry.
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Rectangle | - Ist Comb
I In the Work Plane toolbar, click |:| Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - 1st Comb in the Label text
field.

Locate the Size and Shape section. In the Width text field, type 1_rotor.
In the Height text field, type w_rotor.

Locate the Position section. From the Base list, choose Center.

In the xw text field, type y_spring_1/2+w_mass/2+1_rotor/2.

In the yw text field, type w_mass/2-rotor_spacing-w_rotor/2.

0 N o0 U1 AW

Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. Click New.
9 In the New Cumulative Selection dialog box, type Rotors in the Name text field.
10 Click OK.
Work Plane 4 - Rotors (wp4)>ArraKy !. (arrl)
I In the Work Plane toolbar, click /), Transforms and choose Array.
In the Settings window for Array, locate the Input section.
From the Input objects list, choose Rotors.

2
3
4 Locate the Size section. From the Array type list, choose Linear.
5 In the Size text field, type n_combs.

6

Locate the Displacement section. In the yw text field, type - (rotor_spacing+
w_rotor).

Work Plane 4 - Rotors (wp4)>MirrKor,I (mirl)

I In the Work Plane toolbar, click /), Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Rotors.

4 Seclect the Keep input objects check box.

5 Locate the Point on Line of Reflection section. In the xw text field, type y_spring_1/2.
Work Plane 4 - Rotors (wp4)>MirrKor,2 (mir2)

I In the Work Plane toolbar, click /), Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.

3 From the Input objects list, choose Rotors.

4 Seclect the Keep input objects check box.
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Extrude 4 - Rotors
I In the Model Builder window, right-click Geometry | and choose Extrude.

2 In the Settings window for Extrude, type Extrude 4 - Rotors in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

Distances (um)

t_beam

4 Locate the Selections of Resulting Entities scction. Select the Resulting objects selection

check box.
5 From the Show in physics list, choose All levels.
6 Click ™] Build Selected.
Next build the stator combs.
Work Plane 5 - Stators
I In the Geometry toolbar, click '{é,ls Work Plane.
2 In the Settings window for Work Plane, type Work Plane 5 - Stators in the Label text

field.

Work Plane 5 - Stators (wp5)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle | - Ist Comb
I In the Work Plane toolbar, click |:| Rectangle.

2 In the Settings window for Rectangle, type Rectangle 1 - 1st Comb in the Label text
field.

Locate the Size and Shape section. In the Width text field, type 1_rotor.
In the Height text field, type w_stator.

Locate the Position section. From the Base list, choose Center.

o U1 AW

In the xw text field, type y_spring_1/2+w_mass/2+1_rotor/2+1_rotor-
rotor_stator_overlap.

~

In the yw text field, type w_mass/2-0.5*rotor_spacing.

8 Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. Click New.
9 In the New Cumulative Selection dialog box, type Stators in the Name text field.

10 Click OK.
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Work Plane 5 - Stators (wp5)>Array | (arrl)
I In the Work Plane toolbar, click :4: Transforms and choose Array.

In the Settings window for Array, locate the Input section.
From the Input objects list, choose Stators.

2
3
4 Locate the Size section. From the Array type list, choose Linear.
5 In the Size text field, type n_combs+1.

6

Locate the Displacement section. In the yw text field, type - (rotor_spacing+
w_rotor).

Rectangle 2 - Stator Base
I In the Work Plane toolbar, click |:| Rectangle.

2 In the Settings window for Rectangle, type Rectangle 2 - Stator Base in the Label
text field.

Locate the Size and Shape section. In the Width text field, type w_stator_base.
In the Height text field, type w_mass-rotor_spacing+w_stator.

Locate the Position section. From the Base list, choose Center.

o U1 A W

In the xw text field, type y_spring_1/2+w_mass/2+w_stator_base/2+2*1_rotor-
rotor_stator_overlap.

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. Click New.
8 In the New Cumulative Selection dialog box, type Stator Base in the Name text field.
9 Click OK.
Work Plane 5 - Stators (wp5)>MirKroC I (mirl)
I In the Work Plane toolbar, click /), Transforms and choose Mirror.
2 In the Settings window for Mirror, locate the Input section.
3 From the Input objects list, choose Stators.
4 Select the Keep input objects check box.
5 Locate the Point on Line of Reflection section. In the xw text field, type y_spring_1/2.
Work Plane 5 - Stators (wp5)>MirKror, 2 (mir2)
I In the Work Plane toolbar, click /), Transforms and choose Mirror.
2 In the Settings window for Mirror, locate the Input section.
3 From the Input objects list, choose Stators.

4 Select the Keep input objects check box.
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Work Plane 5 - Stators (wp5)>Mirror 3 (mir3)
I In the Work Plane toolbar, click :‘: Transforms and choose Mirror.

2 In the Settings window for Mirror, locate the Input section.
3 From the Input objects list, choose Stator Base.

4 Seclect the Keep input objects check box.

Rectangle 3 - Stator Base

I In the Work Plane toolbar, click || Rectangle.

2 In the Settings window for Rectangle, type Rectangle 3 - Stator Base in the Label
text field.

3 Locate the Size and Shape section. In the Width text field, type 2* (y_spring_1/2-
1 mass/2-1_rotor-(1l_rotor-rotor_stator_overlap)).

4 In the Height text field, type w_mass-rotor_spacing+w_stator.
5 Locate the Position section. From the Base list, choose Center.

6 Locate the Selections of Resulting Entities scction. Find the Cumulative selection

subsection. From the Contribute to list, choose Stator Base.
Extrude 5 - Stators
I In the Model Builder window, right-click Geometry | and choose Extrude.
2 In the Settings window for Extrude, type Extrude 5 - Stators in the Label text ficld.

3 Locate the Distances section. In the table, enter the following settings:

Distances (um)

t_beam

4 Locate the Selections of Resulting Entities scction. Select the Resulting objects selection
check box.

5 From the Show in physics list, choose All levels.

6 Click ™ Build Selected.

Then build the sense electrodes.
Work Plane 6 - Sense Electrodes
I In the Geometry toolbar, click %\— Work Plane.

2 In the Settings window for Work Plane, type Work Plane 6 - Sense Electrodes in
the Label text field.

3 Locate the Plane Definition section. In the z-coordinate text field, type -t_anchor.
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4

Locate the Selections of Resulting Entities section. Select the Resulting objects selection

check box.

Work Plane 6 - Sense Electrodes (wpé)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Rectangle | - Sense electrode

|
2

N o v b

9

In the Work Plane toolbar, click |:| Rectangle.

In the Settings window for Rectangle, type Rectangle 1 - Sense electrode in the
Label text field.

Locate the Size and Shape section. In the Width text field, type electrode_ratio*
1_mass.

In the Height text field, type electrode_ratio*w_mass.
Locate the Position section. From the Base list, choosc Center.
In the xw text field, type y_spring_1/2.

Locate the Selections of Resulting Entities scction. Find the Cumulative selection

subsection. Click New.

In the New Cumulative Selection dialog box, type Sense electrode in the Name text
field.

Click OK.

Point | - For mesh copy

|
2
3

In the Work Plane toolbar, click - Point.
In the Settings window for Peint, type Point 1 - For mesh copy in the Label text field.

Locate the Point section. In the xw text field, type y_spring_1/2-electrode_ratio*
1 mass/2.

In the yw text field, type electrode_ratio*w_mass/5.

Locate the Selections of Resulting Entities section. Find the Cumulative selection

subsection. From the Contribute to list, choose Sense electrode.

Work Plane 6 - Sense Electrodes (wpé)>Mirror | (mirl)

I
2
3
4

In the Work Plane toolbar, click ), Transforms and choose Mirror.
In the Settings window for Mirror, locate the Input section.
From the Input objects list, choose Sense electrode.

Select the Keep input objects check box.

Finally build the symmetry plane for meshing.
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Work Plane 7 - Symmetry Plane
I In the Model Builder window, right-click Geometry | and choose Work Plane.

2 In the Settings window for Work Plane, type Work Plane 7 - Symmetry Plane in the
Label text field.

3 Locate the Plane Definition section. From the Plane list, choose yz-plane.

Work Plane 7 - Symmetry Plane (wp7)>Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane 7 - Symmetry Plane (wp7)>Cross Section | (crol)
I In the Work Plane toolbar, click “‘\é;» Cross Section.

2 In the Settings window for Cress Section, locate the Selections of Resulting Entities

section.
3 Find the Cumulative selection subsection. Click New.

4 In the New Cumulative Selection dialog box, type Symmetry Plane in the Name text
field.

5 Click OK.

Form Union (fin)
I In the Home toolbar, click [EE Build All.
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2 In the Model Builder window, under Component | (compl)>Geometry | click

Form Union (fin).

Now create additional selections to make it easy to set up the physics and mesh. Turn on

wireframe rendering to see the selection more easily.

DEFINITIONS

Box | - Bottom of Beam

1
2
3
4
5
6

7

In the Definitions toolbar, click |@] Box.

In the Settings window for Box, type Box 1 - Bottom of Beamin the Label text field.
Locate the Geometric Entity Level section. From the Level list, choose Boundary.

Locate the Box Limits section. In the z minimum text field, type -delta.

In the z maximum text field, type delta.

Locate the Output Entities section. From the Include entity if list, choose
Entity inside box.

Click the @ Wireframe Rendering button in the Graphics toolbar.

Box 2 - Entire Beam Layer

In the Definitions toolbar, click |@| Box.
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2 In the Settings window for Box, type Box 2 - Entire Beam Layer in the Label text
field.

3 Locate the Box Limits section. In the z minimum text field, type t_beam/2-delta.
4 In the z maximum text field, type t_beam/2+delta.

Box | - Bottom of Beam
In the Model Builder window, right-click Box | - Bottom of Beam and choose Duplicate.

Box 3 - Anchor base
I In the Model Builder window, under Component | (comp 1)>Definitions>Selections click

Box | - Bottom of Beam 1I.
2 In the Settings window for Box, type Box 3 - Anchor base in the Label text field.
3 Locate the Box Limits section. In the z minimum text field, type -t_anchor-delta.
4 In the z maximum text field, type -t_anchor+delta.
Intersection | - Lower Electrode
I In the Definitions toolbar, click @.‘ Intersection.

2 In the Settings window for Intersection, type Intersection 1 - Lower Electrode in
the Label text ficld.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click — Add.

5 In the Add dialog box, sclect Box | - Bottom of Beam in the Selections to intersect list.
6 Click OK.

7 In the Settings window for Intersection, locate the Input Entities section.

8 Under Selections to intersect, click -+ Add.

9 In the Add dialog box, select Extrude | - Mass in the Selections to intersect list.

10 Click OK.

Create selections for the vertical walls of the comb drives.
Box 4 - Comb vertical walls |
I In the Definitions toolbar, click |@] Box.

2 In the Settings window for Box, type Box 4 - Comb vertical walls 1 in the Label
text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type y_spring_1/2+
w_mass/2+1_rotor/2-delta.
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5 In the x maximum text field, type y_spring_l/2+w_mass/2+1_rotor/2+delta.
6 In the y minimum text field, type -w_mass/2+delta.

7 In the y maximum text field, type w_mass/2-delta.

8 In the z minimum text field, type t_beam/2.

9 In the z maximum text field, type t_beam/2+delta.

10 Right-click Box 4 - Comb vertical walls | and choose Duplicate.

Box 5 - Comb vertical walls 2

I In the Model Builder window, under Component | (compl)>Definitions>Selections click

Box 4 - Comb vertical walls 1.1.

2 In the Settings window for Box, type Box 5 - Comb vertical walls 2 in the Label
text field.

3 Locate the Box Limits section. In the x minimum text field, type - (y_spring_1/2+
w_mass/2+1_rotor/2)-delta.

4 In the x maximum text field, type - (y_spring_l/2+w_mass/2+1_rotor/2)+delta.

Box 4 - Comb vertical walls |
In the Model Builder window, right-click Box 4 - Comb vertical walls | and choose Duplicate.

Box 6 - Comb vertical walls 3
I In the Model Builder window, under Component | (comp I)>Definitions>Selections click

Box 4 - Comb vertical walls 1.1.

2 In the Settings window for Box, type Box 6 - Comb vertical walls 3 in the Label
text field.

3 Locate the Box Limits section. In the x minimum text field, type y_spring_1/2-
w_mass/2-1_rotor/2 -delta.

4 In the x maximum text field, type y_spring_1/2-w_mass/2-1_rotor/2+delta.

Box 5 - Comb vertical walls 2
In the Model Builder window, right-click Box 5 - Comb vertical walls 2 and choose Duplicate.

Box 7 - Comb vertical walls 4

I In the Model Builder window, under Component | (compl)>Definitions>Selections click
Box 5 - Comb vertical walls 2.1.

2 In the Settings window for Box, type Box 7 - Comb vertical walls 4 in the Label
text field.

3 Locate the Box Limits section. In the x minimum text field, type - (y_spring_1/2-
w_mass/2-1_rotor/2)-delta.
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4 In the x maximum text field, type - (y_spring_1/2-w_mass/2-1_rotor/2)+delta.
Union | - Comb Vertical Walls )
I In the Definitions toolbar, click @l. Union.

2 In the Settings window for Union, type Union 1 - Comb Vertical Walls in the Label
text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
4 Locate the Input Entities section. Under Selections to add, click - Add.

5 In the Add dialog box, in the Selections to add list, choose Box 4 - Comb vertical walls I,
Box 5 - Comb vertical walls 2, Box 6 - Comb vertical walls 3, and Box 7 -

Comb vertical walls 4.
6 Click OK.
Intersection 2 - Stator Vertical Walls
I In the Definitions toolbar, click @. Intersection.

2 In the Settings window for Intersection, type Intersection 2 - Stator Vertical
Walls in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
4 Locate the Input Entities section. Under Selections to intersect, click - Add.

5 In the Add dialog box, in the Selections to intersect list, choose Union 1 -
Comb Vertical Walls and Extrude 5 - Stators.

6 Click OK.
Create selections for the end edges of the comb drives.

Box 4 - Comb vertical walls |

In the Model Builder window, right-click Box 4 - Comb vertical walls | and choose Duplicate.

Box 8 - Rotor tip edge |
I In the Model Builder window, under Component | (compl)>Definitions>Selections click

Box 4 - Comb vertical walls I.1.
2 In the Settings window for Box, type Box 8 - Rotor tip edge 1 in the Label text ficld.
3 Locate the Geometric Entity Level section. From the Level list, choose Edge.

4 Locate the Box Limits section. In the x minimum text field, type y_spring_1/2+
w_mass/2+1_rotor-delta.

5 In the x maximum text field, type y_spring_1/2+w_mass/2+1_rotor+delta.

6 Right-click Box 8 - Rotor tip edge | and choosc Duplicate.
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Box 9 - Rotor tip edge 2
I In the Model Builder window, under Component | (comp I)>Definitions>Selections click

Box 8 - Rotor tip edge I.1.
2 In the Settings window for Box, type Box 9 - Rotor tip edge 2 in the Label text field.

3 Locate the Box Limits section. In the x minimum text field, type - (y_spring_1/2+
w_mass/2+1_rotor)-delta.

4 In the x maximum text field, type - (y_spring_l/2+w_mass/2+1_rotor)+delta.

Box 8 - Rotor tip edge |
In the Model Builder window, right-click Box 8 - Rotor tip edge | and choose Duplicate.

Box 10 - Rotor tip edge 3
I In the Model Builder window, under Component | (comp 1)>Definitions>Selections click

Box 8 - Rotor tip edge I.1.

2 In the Settings window for Box, type Box 10 - Rotor tip edge 3 in the Label text
field.

3 Locate the Box Limits section. In the x minimum text field, type y_spring_1/2-
w_mass/2-1_rotor -delta.

4 In the x maximum text field, type y_spring_1/2-w_mass/2-1_rotor+delta.

Box 9 - Rotor tip edge 2
In the Model Builder window, right-click Box 9 - Rotor tip edge 2 and choose Duplicate.

Box I'| - Rotor tip edge 4
I In the Model Builder window, under Component | (compl)>Definitions>Selections click

Box 9 - Rotor tip edge 2.1.

2 In the Settings window for Box, type Box 11 - Rotor tip edge 4 in the Label text
field.

3 Locate the Box Limits section. In the x minimum text field, type - (y_spring_1/2-
w_mass/2-1_rotor)-delta.

4 In the x maximum text field, type - (y_spring_l/2-w_mass/2-1_rotor)+delta.
Union 2 - Rotor Tip Edges +X DC
I In the Definitions toolbar, click @l. Union.

2 In the Settings window for Unien, type Union 2 - Rotor Tip Edges +X DC in the
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.

4 Locate the Input Entities section. Under Selections to add, click -+ Add.
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5 In the Add dialog box, in the Selections to add list, choose Box 8 - Rotor tip edge | and
Box 11 - Rotor tip edge 4.

6 Click OK.
Union 3 - Rotor Tip Edges -X DC
I In the Definitions toolbar, click @l. Union.

2 In the Settings window for Union, type Union 3 - Rotor Tip Edges -X DCin the
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.
4 Locate the Input Entities section. Under Selections to add, click - Add.

5 In the Add dialog box, in the Selections to add list, choosc Box 9 - Rotor tip edge 2 and
Box 10 - Rotor tip edge 3.

6 Click OK.
Union 4 - Rotor Tip Edges +X AC
I In the Definitions toolbar, click @l. Union.

2 In the Settings window for Union, type Union 4 - Rotor Tip Edges +X ACin the
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.
4 Locate the Input Entities section. Under Selections to add, click - Add.

5 In the Add dialog box, in the Selections to add list, choosc Box 8 - Rotor tip edge | and
Box 9 - Rotor tip edge 2.

6 Click OK.
Union 5 - Rotor Tip Edges -X AC
I In the Definitions toolbar, click @l. Union.

2 In the Settings window for Union, type Union 5 - Rotor Tip Edges -X AC in the
Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.
4 Locate the Input Entities section. Under Selections to add, click - Add.

5 In the Add dialog box, in the Selections to add list, choose Box 10 - Rotor tip edge 3 and
Box Il - Rotor tip edge 4.

6 Click OK.

Union 6 - Rotor Tip Edges )
I In the Definitions toolbar, click @l. Union.
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2 In the Settings window for Union, type Union 6 - Rotor Tip Edges in the Label text
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Edge.
4 Locate the Input Entities section. Under Selections to add, click - Add.

5 In the Add dialog box, in the Selections to add list, choose Union 2 - Rotor Tip Edges +
X DC and Union 3 - Rotor Tip Edges -X DC.

6 Click OK.

Create selections for meshing.
Box I3 - x > 0 Beam base
I In the Definitions toolbar, click |@| Box.
In the Settings window for Box, type Box 13 - x > 0 Beam base in the Label text field.

Locate the Geometric Entity Level section. From the Level list, choose Boundary.

2
3
4 Locate the Box Limits section. In the x minimum text field, type -delta.
5 In the z minimum text field, type -delta.

6 In the z maximum text field, type delta.

7

Locate the Output Entities section. From the Include entity if list, choose
Entity inside box.

Box 13 - x 0 Beam base
Right-click Box 13 - x 0 Beam base and choose Duplicate.

Box /4 - x < 0 Beam base
I In the Model Builder window, under Component | (compl)>Definitions>Selections click
Box 13 - x 0 Beam base |I.

2 In the Settings window for Box, type Box 14 - x < 0 Beam base in the Label text field.
3 Locate the Box Limits section. In the x minimum text field, type - Inf.

4 In the x maximum text field, type delta.

5 Right-click Box 14 - x < 0 Beam base and choosc Duplicate.

Box I5 - x > 0 Spring Anchor

I In the Model Builder window, under Component | (comp I)>Definitions>Selections click
Box 14 - x < 0 Beam base |I.

2 In the Settings window for Box, type Box 15 - x > 0 Spring Anchor in the Label text
field.
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3 Locate the Box Limits section. In the x minimum text field, type -delta+tether_x-
w_anchor/2.

4 In the x maximum text field, type delta+tether_x+w_anchor/2.

Box 15 - x 0 Spring Anchor
Right-click Box 15 - x 0 Spring Anchor and choose Duplicate.

Box 16 - x < 0 Spring Anchor
I In the Model Builder window, under Component | (compl)>Definitions>Selections click

Box 15 - x 0 Spring Anchor |.

2 In the Settings window for Box, type Box 16 - x < 0 Spring Anchor in the Label text
field.

3 Locate the Box Limits section. In the x minimum text field, type -delta-tether_x-
w_anchor/2.

4 In the x maximum text field, type delta-tether_x+w_anchor/2.
Intersection 3 - Quad Mesh - Springs Construction
I In the Definitions toolbar, click @. Intersection.

2 In the Settings window for Intersection, type Intersection 3 - Quad Mesh -
Springs Construction in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
4 Locate the Input Entities section. Under Selections to intersect, click - Add.

5 In the Add dialog box, in the Selections to intersect list, choose Box 13 - x > 0 Beam base
and Extrude 3 - Springs.

6 Click OK.
Intersection 4 - Quad Mesh - Springs Construction copy
I In the Definitions toolbar, click @. Intersection.

2 In the Settings window for Intersection, type Intersection 4 - Quad Mesh -
Springs Construction copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
4 Locate the Input Entities section. Under Selections to intersect, click -+ Add.

5 In the Add dialog box, in the Selections to intersect list, choose Box 14 - x < 0 Beam base

and Extrude 3 - Springs.
6 Click OK.
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Intersection 5 - Mapped Mesh - Anchors
I In the Definitions toolbar, click @l. Intersection.

2 In the Settings window for Intersection, type Intersection 5 - Mapped Mesh -
Anchors in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
4 Locate the Input Entities section. Under Selections to intersect, click -+ Add.

5 In the Add dialog box, in the Selections to intersect list, choose Box 15 - x >

0 Spring Anchor and Extrude 2 - Anchors.
6 Click OK.
Intersection 6 - Mapped Mesh - Anchors copy
I In the Definitions toolbar, click @l. Intersection.

2 In the Settings window for Intersection, type Intersection 6 - Mapped Mesh -
Anchors copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
4 Locate the Input Entities section. Under Selections to intersect, click — Add.

5 In the Add dialog box, in the Selections to intersect list, choose Box 16 -
x < 0 Spring Anchor and Extrude 2 - Anchors.

6 Click OK.
Intersection 7 - Triangular Mesh - Mass
I In the Definitions toolbar, click @l. Intersection.

2 In the Settings window for Intersection, type Intersection 7 - Triangular Mesh -
Mass in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
4 Locate the Input Entities section. Under Selections to intersect, click — Add.

5 In the Add dialog box, in the Selections to intersect list, choose Box 13 - x > 0 Beam base

and Extrude | - Mass.
6 Click OK.
Intersection 8 - Triangular Mesh - Mass copy
I In the Definitions toolbar, click @. Intersection.

2 In the Settings window for Intersection, type Intersection 8 - Triangular Mesh -
Mass copy in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to intersect, click - Add.
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5

6

In the Add dialog box, in the Selections to intersect list, choose Box 14 - x < 0 Beam base

and Extrude | - Mass.

Click OK.

Difference | - Quad Mesh - Springs

In the Definitions toolbar, click @l. Difference.

2 In the Settings window for Difference, type Difference 1 - Quad Mesh - Springs
in the Label text field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click - Add.

5 In the Add dialog box, sclect Intersection 3 - Quad Mesh - Springs Construction in the
Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click - Add.

9 In the Add dialog box, select Intersection 5 - Mapped Mesh - Anchors in the
Selections to subtract list.

10 Click OK.

Difference 2 - Quad Mesh - Springs copy

|
2

[, ]

NV O N o

In the Definitions toolbar, click @l. Difference.

In the Settings window for Difference, type Difference 2 - Quad Mesh - Springs
copy in the Label text field.

Locate the Geometric Entity Level section. From the Level list, choose Boundary.
Locate the Input Entities section. Under Selections to add, click — Add.

In the Add dialog box, select Intersection 4 - Quad Mesh - Springs Construction copy in the

Selections to add list.

Click OK.

In the Settings window for Difference, locate the Input Entities section.
Under Selections to subtract, click - Add.

In the Add dialog box, select Intersection 6 - Mapped Mesh - Anchors copy in the

Selections to subtract list.

10 Click OK.
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Difference 3 - Quad Mesh -Stator & Comb
I In the Definitions toolbar, click @l. Difference.

2 In the Settings window for Difference, type Difference 3 - Quad Mesh -Stator &
Comb in the Label text field.

Locate the Geometric Entity Level section. From the Level list, choose Boundary.
Locate the Input Entities section. Under Selections to add, click -+ Add.

In the Add dialog box, select Box 13 - x > 0 Beam base in the Selections to add list.
Click OK.

In the Settings window for Difference, locate the Input Entities section.

Under Selections to subtract, click -+ Add.

NV O N O 1 AW

In the Add dialog box, in the Selections to subtract list, choose Box 15 - x >
0 Spring Anchor, Extrude | - Mass, Extrude 3 - Springs, and Work Plane 6 -
Sense Electrodes.

10 Click OK.
Difference 4 - Quad Mesh -Stator & Comb copy
I In the Definitions toolbar, click @l. Difference.

2 In the Settings window for Difference, type Difference 4 - Quad Mesh -Stator &
Comb copy in the Label text field.

Locate the Geometric Entity Level section. From the Level list, choose Boundary.
Locate the Input Entities section. Under Selections to add, click — Add.

In the Add dialog box, select Box 14 - x < 0 Beam base in the Selections to add list.
Click OK.

In the Settings window for Difference, locate the Input Entities section.

Under Selections to subtract, click -+ Add.

NV O N o0 1 AW

In the Add dialog box, in the Selections to subtract list, choosec Box 16 -
x < 0 Spring Anchor, Extrude | - Mass, Extrude 3 - Springs, and Work Plane 6 -
Sense Electrodes.

10 Click OK.
Box |7 - x > 0 Anchor base
I In the Definitions toolbar, click |@] Box.

2 In the Settings window for Box, type Box 17 - x > 0 Anchor base in the Label text
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.
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4
5
6
7

Locate the Box Limits section. In the x minimum text field, type -delta.
In the z minimum text field, type -delta-t_anchor.
In the z maximum text field, type delta-t_anchor.

Locate the Output Entities section. From the Include entity if list, choose

Entity inside box.

Box 17 - x 0 Anchor base
Right-click Box 17 - x 0 Anchor base and choose Duplicate.

Box I8 - x < 0 Anchor base

3
4

In the Model Builder window, under Component | (comp I)>Definitions>Selections click
Box 17 - x 0 Anchor base 1.

In the Settings window for Box, type Box 18 - x < 0 Anchor base in the Label text
field.

Locate the Box Limits section. In the x minimum text field, type - Inf.

In the x maximum text field, type delta.

Intersection 9 - Triangular Mesh - Sense Electrode

|
2

6

In the Definitions toolbar, click @.‘ Intersection.

In the Settings window for Intersection, type Intersection 9 - Triangular Mesh -
Sense Electrode in the Label text field.

Locate the Geometric Entity Level section. From the Level list, choose Boundary.
Locate the Input Entities section. Under Selections to intersect, click -+ Add.

In the Add dialog box, in the Selections to intersect list, choose Box 17 - x >

0 Anchor base and Work Plane 6 - Sense Electrodes.

Click OK.

Intersection 10 - Triangular Mesh - Sense Electrode copy

|
2

In the Definitions toolbar, click @l. Intersection.

In the Settings window for Intersection, type Intersection 10 - Triangular Mesh
- Sense Electrode copy in the Label text field.

Locate the Geometric Entity Level section. From the Level list, choose Boundary.
Locate the Input Entities section. Under Selections to intersect, click — Add.

In the Add dialog box, in the Selections to intersect list, choose Box 18 -

x < 0 Anchor base and Work Plane 6 - Sense Electrodes.

Click OK.
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Finally create selection for the effective regions of the lower electrodes.
Box 19 - x > 0 Lower electrode effective region
I In the Definitions toolbar, click |@| Box.

2 In the Settings window for Box, type Box 19 - x > 0 Lower electrode effective
region in the Label text ficld.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Box Limits section. In the x minimum text field, type -delta+y_spring_1/
2-electrode_ratio*1 _mass/2.

5 In the x maximum text field, type delta+y_spring_l/2+electrode_ratio*1_mass/
2.

6 In the y minimum text field, type -delta-electrode_ratio*w_mass/2.
7 In the y maximum text field, type deltatelectrode_ratio*w_mass/2.
8 In the z minimum text field, type -delta.

9 In the z maximum text field, type delta.

10 Locate the Output Entities scction. From the Include entity if list, choose

Entity inside box.

Box 19 - x 0 Lower electrode effective region
Right-click Box 19 - x 0 Lower electrode effective region and choose Duplicate.

Box 20 - x < 0 Lower electrode effective region
I In the Model Builder window, under Component | (comp I)>Definitions>Selections click

Box 19 - x 0 Lower electrode effective region I.

2 In the Settings window for Box, type Box 20 - x < 0 Lower electrode effective
region in the Label text ficld.

3 Locate the Box Limits section. In the x minimum text field, type -delta-y_spring_1/
2-electrode_ratio*1_mass/2.

4 In the x maximum text field, type delta-y_spring_l/2+electrode_ratio*1l_mass/
2.

Union 7 - Lower electrode effective region

I In the Definitions toolbar, click @. Union.

2 In the Settings window for Union, type Union 7 - Lower electrode effective
region in the Label text ficld.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click - Add.
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In the Add dialog box, in the Selections to add list, choose Box 19 - x >
0 Lower electrode effective region and Box 20 - x < 0 Lower electrode effective region.

Click OK.

While a predefined, fully-coupled Electromechanics multiphysics is available, in this
model we demonstrate the use of analytic formulas for computing the electrostatic
forces. Create extrusion and integration operators to be used in the analytic formulas.

In the Model Builder window, collapse the Component | (comp1)>Definitions>Selections

node.

General Extrusion | - Stator Walls

|
2

8

In the Definitions toolbar, click (//// Nonlocal Couplings and choose General Extrusion.

In the Settings window for General Extrusion, type General Extrusion 1 - Stator
Walls in the Label text field.

In the Operator name text field, type genextcmb.

Locate the Source Selection scction. From the Geometric entity level list, choose

Boundary.
From the Selection list, choose Intersection 2 - Stator Vertical Walls.
Locate the Source section. Select the Use source map check box.

Click to expand the Advanced section. From the Mesh search method list, choose
Closest point.

This extrusion operator will be used to compute the distance between the tips of the
rotors to the vertical walls of the stators as part of the comb-drive force and capacitance

calculation.

Right-click General Extrusion | - Stator Walls and choosc Duplicate.

General Extrusion 2 - Sense Electrodes

In the Model Builder window, under Component | (compl)>Definitions click

General Extrusion | - Stator Walls | (genextcmb2).

In the Settings window for General Extrusion, type General Extrusion 2 - Sense
Electrodes in the Label text field.

In the Operator name text field, type genextpp.

Locate the Source Selection scction. From the Selection list, choose Work Plane 6 -

Sense Electrodes.

This extrusion operator will be used to compute the distance between the sense
clectrodes to the bottom surfaces of the proof masses as part of the parallel-plate force

and capacitance calculation.
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Integration | - Lower Electrodes

|
2

5

In the Definitions toolbar, click (//// Nonlocal Couplings and choose Integration.

In the Settings window for Integration, type Integration 1 - Lower Electrodes in
the Label text field.

In the Operator name text field, type intoppp.

Locate the Source Selection scction. From the Geometric entity level list, choose

Boundary.

From the Selection list, choose Union 7 - Lower electrode effective region.

Integration 2 - Comb Edges

|
2

3
4
5

In the Definitions toolbar, click {//// Nonlocal Couplings and choose Integration.

In the Settings window for Integration, type Integration 2 - Comb Edges in the Label
text field.

In the Operator name text field, type intopcmb.
Locate the Source Selection section. From the Geometric entity level list, choose Edge.

From the Selection list, choose Union 6 - Rotor Tip Edges.

Now we are ready to enter the analytic formulas and other useful variables, first for the

sense electrodes. Note how the extrusion operator is used to compute the gap distance

between the parallel plate electrodes. Also a spatially dependent variable, sign, is created

to provide the correct phase factor for the estimation of the sense mode amplitude (to be

performed during postprocessing). The formula for the force on the parallel plate

capacitor can be found in standard textbooks such as Ref. 2 (Chapter 15).

Variables | - Sense Capacitor

|
2

In the Model Builder window, right-click Definitions and choose Variables.

In the Settings window for Variables, type Variables 1 - Sense Capacitor in the
Label text field.

Locate the Geometric Entity Selection section. From the Geometric entity level list,

choose Boundary.

From the Selection list, choose Union 7 - Lower electrode effective region.
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5 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description
dpp_x genextpp(X) - (X+u) m Vector from lower
electrode, x
dpp_y genextpp(Y)-(Y+v) m Vector from lower
electrode, y
dpp_z genextpp(Z) - (Z+w) m Vector from lower
electrode, z
dpp_sq dpp_x"2+dpp_y~2+dpp_z"2 m? Square of parallel
plate distance
F_A 0.5*epsilon0_const* Pa Force per unit area of
Vbase~2/dpp_sq electrode
C_A epsilon0_const/ F/m? Capacitance per unit
sqrt(dpp_sq) area of electrode

Variables 2 - Sense Capacitor + sign AC
I Right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 2 - Sense Capacitor + sign
AC in the Label text field.

3 Locate the Geometric Entity Selection scction. From the Geometric entity level list,

choose Boundary.
4 From the Selection list, choose Box 20 - x < 0 Lower electrode effective region.

5 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

sign 1 Sign of capacitance change

6 Right-click Variables 2 - Sense Capacitor + sign AC and choose Duplicate.

Variables 3 - Sense Capacitor - sign AC

I In the Model Builder window, under Component | (compl)>Definitions click Variables 2 -
Sense Capacitor + sign AC I.

2 In the Settings window for Variables, type Variables 3 - Sense Capacitor - sign
AC in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Box 19 -

x > 0 Lower electrode effective region.
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4 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

sign -1 Sign of capacitance change

Then for the comb drives. Here since the force directions of the combs are different
between the DC bias and the AC drive, two spatially dependent variables, sign and AC,
are used to provide correct directions and phase factors. The linper operator is used to
delineate the AC part of the drive voltage V_ac. In addition, the parameter AC_on is used
to turn the AC drive on or off. The formula for the comb drive force can be found in
standard textbooks such as Ref. 2 (Chapter 15). The formula gives the overall force from
energy arguments. This overall force can be divided up into separate contributions in
different parts of the model in various ways. In this model we choose to divide the overall
force into edge loads at the tips of the rotors. Note how the extrusion operator is used to
compute the distance between the edges and the vertical walls of the stators as part of the

force calculation.
Variables 4 - Comb Drives
I In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 4 - Comb Drives in the Label
text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list,
choose Edge.

4 From the Selection list, choose Union 6 - Rotor Tip Edges.

5 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

dcmb_x genextcmb (X+u) - (X+u) m Vector from
rotor comb
edge, x

dcmb_y genextcmb (Y+v) - (Y+v) m Vector from
rotor comb
edge, y

dcmb_z genextcmb (Z+w) - (Z+w) m Vector from
rotor comb
edge, z

dcmb sqrt(dcmb_x"~2+dcmb_y~2+dcmb_z"2) m Parallel
plate
distance
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Name Expression Unit Description

Vtot Vcomb+AC_on*AC*1inper(V_ac) Total
voltage
F 1 sign*0.5*epsilon0_const*Vtot~2/ Force per
dcmb unit length
of edge
C 1 linpoint(epsilon0_const/dcmb)*u* Capacitance
sign*AC change per

unit length

Variables 5 - Comb Drives + sign DC
I Right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 5 - Comb Drives + sign DC
in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list,

choose Edge.
4 From the Selection list, choose Union 2 - Rotor Tip Edges +X DC.

5 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

sign 1 Sign of comb drive force

6 Right-click Variables 5 - Comb Drives + sign DC and choose Duplicate.

Variables 6 - Comb Drives - sign DC
I In the Model Builder window, under Component | (compl)>Definitions click Variables 5 -

Comb Drives + sign DC I.

2 In the Settings window for Variables, type Variables 6 - Comb Drives - sign DC
in the Label text field.

3 Locate the Geometric Entity Selection scction. From the Selection list, choose Union 3 -
Rotor Tip Edges -X DC.

4 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

sign -1 Sign of comb drive force

Variables 7 - Comb Drives + sign AC
I In the Model Builder window, right-click Definitions and choose Variables.
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2 In the Settings window for Variables, type Variables 7 - Comb Drives + sign AC
in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list,
choose Edge.

4 From the Selection list, choose Union 4 - Rotor Tip Edges +X AC.

5 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

AC 1 Sign of AC comb voltage

6 Right-click Variables 7 - Comb Drives + sign AC and choose Duplicate.

Variables 8 - Comb Drives - sign AC
I In the Model Builder window, under Component | (compl)>Definitions click Variables 7 -

Comb Drives + sign AC I.

2 In the Settings window for Variables, type Variables 8 - Comb Drives - sign AC
in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Union 5 -
Rotor Tip Edges -X AC.

4 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

AC -1 Sign of AC comb voltage

Now add the Polycrystalline Silicon material from the library.

ADD MATERIAL
I In the Home toolbar, click 35 Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select MEMS>Semiconductors>Si - Polycrystalline silicon.

4 Click Add to Component in the window toolbar.

5 In the Home toolbar, click «, Add Material to close the Add Material window.

Configure the physics settings. Use the previously defined variables for the electrostatic

forces. Turn on the Coriolis Force option.
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SOLID MECHANICS (SOLID)

Linear Elastic Material |

In the Model Builder window, under Component | (comp1)>Solid Mechanics (solid) click
Linear Elastic Material I.

Damping |

I In the Physics toolbar, click |=° Attributes and choose Damping.

2 In the Settings window for Damping, locate the Damping Settings section.

3 From the Damping type list, choose Isotropic loss factor.

4 From the ng list, choose User defined. In the associated text field, type 1/Q.

Fixed Constraint |

I In the Physics toolbar, click mw Boundaries and choose Fixed Constraint.

2 In the Settings window for Fixed Constraint, locate the Boundary Selection scction.
3 From the Selection list, choose Box 3 - Anchor base.

Boundary Load | - Sense Electrodes

I In the Physics toolbar, click mw Boundaries and choosec Boundary Load.

2 In the Settings window for Boundary Load, type Boundary Load 1 - Sense
Electrodes in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Union 7 -

Lower electrode effective region.

4 Locate the Force section. Specify the Fp vector as
-F_A z

Edge Load | - Comb Drives
I In the Physics toolbar, click

\— Edges and choosc Edge Load.

2 In the Settings window for Edge Load, type Edge Load 1 - Comb Drives in the Label
text field.

3 Locate the Edge Selection section. From the Selection list, choose Union 6 -

Rotor Tip Edges.

4 Locate the Force section. Specify the Fy, vector as
F 1 x

Rotating Frame |
I In the Physics toolbar, click {8 Demains and choose Rotating Frame.
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2 In the Settings window for Rotating Frame, locate the Rotating Frame section.

3 From the Axis of rotation list, choose y-axis.

4 In the Q text field, type Omega.

5 Locate the Frame Acceleration Effect section. Select the Coriolis force check box.

Set up the mesh. To save time and file size, a somewhat coarse mesh is used. Nevertheless
the mesh is parameterized to be ready for refinement studies. In the followup model, the
Deformed Geometry feature will be used to study the effects of manufacturing tolerances,

with the advantage that it keeps the same mesh while varying the geometry, thus avoiding
unwanted variations caused by a different mesh being used for a different geometry.

MESH 1|
Mapped |
I In the Mesh toolbar, click L More Generators and choosc Mapped.

2 In the Settings window for Mapped, locate the Boundary Selection section.
3 From the Selection list, choose Box 15 - x > 0 Spring Anchor.
Size |
I Right-click Mapped I and choose Size.
In the Settings window for Size, locate the Element Size section.

2

3 Click the Custom button.

4 Locate the Element Size Parameters section.
5

Select the Maximum element size check box. In the associated text field, type
mesh_factor*x_spring_w/2.

6 Sclect the Minimum element size check box. In the associated text field, type
mesh_factor*x_spring_w/10.

Size

I In the Model Builder window, under Component | (compl)>Mesh I click Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element size text field, type
mesh_factor*tether_w/3.

5 In the Minimum element size text field, type mesh_factor*tether_w/30.

6 In the Maximum element growth rate text field, type 1.1+mesh_factor*0.2.
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Copy Face |
I In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.
3 From the Selection list, choose Box 15 - x > 0 Spring Anchor.
4 Locate the Destination Boundaries scction. From the Selection list, choose Box 16 -

x < 0 Spring Anchor.

Free Quad |
I In the Mesh toolbar, click /\. More Generators and choose Free Quad.

LA
2 In the Settings window for Free Quad, locate the Boundary Selection section.
3 From the Selection list, choose Difference | - Quad Mesh - Springs.
Size |
I Right-click Free Quad I and choose Size.
In the Settings window for Size, locate the Geometric Entity Selection section.
Click IL:G Clear Selection.
Select Boundaries 945 and 950 only.

2
3
4
5 Locate the Element Size section. Click the Custom button.
6 Locate the Element Size Parameters section.

7

Select the Maximum element size check box. In the associated text field, type
mesh_factor*x_spring_w/3.

8 Sclect the Minimum element size check box. In the associated text field, type
mesh_factor*x_spring_w/30.

Copy Face 2

I In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Difference | - Quad Mesh - Springs.

4 Locate the Destination Boundaries scction. From the Selection list, choose Difference 2 -

Quad Mesh - Springs copy.
5 Click ®] Build Selected.

Size
In the Model Builder window, right-click Size and choose Duplicate.

Size |

I In the Model Builder window, click Size 1.
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2 In the Settings window for Size, locate the Element Size Parameters section.
3 In the Maximum element size text field, type mesh_factor*w_rotor/2.
4 In the Minimum element size text field, type mesh_factor*w_rotor/20.

Free Quad 2

I In the Mesh toolbar, click L More Generators and choose Free Quad.

2 In the Settings window for Free Quad, locate the Boundary Selection section.
3 From the Selection list, choose Difference 3 - Quad Mesh -Stator & Comb.
Copy Face 3

I In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Difference 3 - Quad Mesh -Stator & Comb.

4 Locate the Destination Boundaries section. From the Selection list, choose Difference 4 -
Quad Mesh -Stator & Comb copy.

5 Click ™ Build Selected.

Size |
Right-click Size I and choose Duplicate.

Size 2

I In the Model Builder window, click Size 2.

2 In the Settings window for Size, locate the Element Size Parameters section.
3 In the Maximum element size text field, type mesh_factor*w_rotor.

4 In the Minimum element size text field, type mesh_factor*w_rotor/10.

Free Triangular |

I In the Mesh toolbar, click ‘,"L\ More Generators and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.
3 From the Selection list, choose Intersection 7 - Triangular Mesh - Mass.

Copy Face 4

I In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Intersection 7 - Triangular Mesh - Mass.

4 Locate the Destination Boundaries section. From the Selection list, choose Intersection 8 -

Triangular Mesh - Mass copy.
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Free Triangular 2

I In the Mesh toolbar, click ‘,"L\ More Generators and choose Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Intersection 9 - Triangular Mesh - Sense Electrode.

Copy Face 5

I In the Mesh toolbar, click Copy and choose Copy Face.

2 In the Settings window for Copy Face, locate the Source Boundaries section.

3 From the Selection list, choose Intersection 9 - Triangular Mesh - Sense Electrode.

4 Locate the Destination Boundaries scction. From the Selection list, choose
Intersection 10 - Triangular Mesh - Sense Electrode copy.

Swept |

I In the Mesh toolbar, click 42, Swept.

2 In the Settings window for Swept, locate the Domain Selection scction.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Box 2 - Entire Beam Layer.

Distribution |

I Right-click Swept | and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type max (1, floor (3/mesh_factor)).

Swept 2
I In the Mesh toolbar, click

. Swept.

2 In the Settings window for Swept, locate the Domain Selection section.
3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Extrude 2 - Anchors.

Distribution |

I Right-click Swept 2 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type max (1, floor (3/mesh_factor)).
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4 1In the Mesh toolbar, click [E8 Build Mesh.
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Perform the stationary study.

STUDY | - STATIONARY
I In the Model Builder window, click Study I.

2 In the Set

ngs window for Study, type Study 1 - Stationary in the Label text field.

3 In the Home toolbar, click = Compute.
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RESULTS

Stress (solid)

Volume: von Mises stress (N/m?)

x10°

16

14

12

10

The plot shows that the masses are pulled down slightly by the bias voltage of the sense
electrodes. The masses do not move horizontally since the DC part of the comb drive

forces for each mass are equal and in opposite directions so they cancel out.

Next perform a prestressed eigenfrequency study to find the drive and sense mode
frequencies.

ADD STUDY
I In the Home toolbar, click \')‘i Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select

Preset Studies for Selected Physics Interfaces>Eigenfrequency, Prestressed.
4 Click Add Study in the window toolbar.
5 In the Home toolbar, click \')‘; Add Study to close the Add Study window.

STUDY 2 - PRESTRESSED EIGENFREQUENCY
I In the Model Builder window, click Study 2.
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2 In the Settings window for Study, type Study 2 - Prestressed Eigenfrequency in
the Label text field.

Step I: Stationary
I In the Model Builder window, under Study 2 - Prestressed Eigenfrequency click
Step I: Stationary.

2 In the Settings window for Stationary, locate the Study Settings scction.

3 Select the Include geometric nonlinearity check box.

Step 2: Eigenfrequency

I In the Model Builder window, click Step 2: Eigenfrequency.

2 In the Settings window for Eigenfrequency, locate the Study Settings section.

3 Select the Desired number of eigenfrequencies check box. In the associated text field, type
3.

4 In the Search for eigenfrequencies around shift text field, type 38000[Hz].
5 From the Search method around shift list, choose Larger real part.

6 In the Home toolbar, click = Compute.
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RESULTS

Mode Shape (solid)

Eigenfrequency=38262+38.262i Hz Surface: Displacement magnitude (um)

The plot shows the drive mode, ...
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I In the Settings window for 3D Plot Group, click =* Plot Next.

Eigenfrequency=41125+41.498i Hz Surface: Displacement magnitude (um)

... and the sense mode.

Before continuing to the next study, we use analytic formulas to estimate the drive and
sense mode frequencies, to compare with the numerical result. The global parameter table
serves well for this kind of back-of-the-envelope calculations. In particular, the capability
of including units in the calculation helps detect mistakes. First compute the drive mode.
The total mass of the resonator is calculated straightforwardly. The spring constants of
cach segment of the spring for the drive mode is estimated using standard formulas in
textbooks such as Ref. 2 (section 4.3 Spring design equations). From the mode shape of

the drive mode, the formula for guided beams is used.

GLOBAL DEFINITIONS

Parameters 3 - Estimate drive mode frequency
I In the Home toolbar, click FPi Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 3 - Estimate drive mode
frequency in the Label text field.

54 | A MICROMACHINED COMB-DRIVE TUNING FORK RATE GYROSCOPE



3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description
rho0 2320[kg/m~3] 2320 kg/m? Density
mo rho0*t_beam*2* 2.2272E-9 kg Total mass
(2*n_combs*
1 _rotor*w_rotor+
1 mass*w_mass-
n_etch_x*
n_etch_y*
etch_dim~2)
EO 160e9[Pa] 1.6El|l Pa Young's modulus
10 t_beam* 6.4E-23 m* Area moment of
X_spring_w~3/12 inertia for X
spring in-plane
bending
kO 4*12*E0*I0/ 145.64 N/m Spring constant
X_spring_1~3 for X spring in-
plane bending
I1 t_beam* IE-21 m* Area moment of
y_spring_w~3/12 inertia for Y
spring in-plane
bending
y_spring_13 y_spring_1/2- 1.2E-4 m Length of Y spring
tether_x between tether
and X spring
k1 4*12*EQ*I1/ 4444.4 N/m Spring constant
y_spring_13"3 for Y spring in-
plane bending
k_tot 1/(1/k0+1/k1) 141.01 N/m Total spring
constant for in-
plane bending
fo sqrt(k_tot/m0)/ 40047 l/s Estimated drive

2/pi

mode frequency

The estimated drive mode frequency of 40 kHz is not too far away from the computed

value of 38 kHz. Next the sense mode, which involves both bending and twisting of the

springs. Therefore the formulas for both guided beams and torsional springs are used in

the estimation.

Parameters 4 - Estimate sense mode frequency

I In the Home toolbar, click Pi Parameters and choose Add>Parameters.
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2 In the Settings window for Parameters, type Parameters 4 - Estimate sense mode
frequency in the Label text field.
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3 Locate the Parameters section

. In the table, enter the following settings:

Name Expression Value Description
12 t_beam~3* 5.76E-22 m* Area moment of
X_spring_w/12 inertia for X spring
out-of-plane
bending
k2 4*12*EQ*I2/ 1310.7 N/m Spring constant for
Xx_spring_1"3 X spring out-of-
plane bending
I3 t_beam~3* | 44E-21 m* Area moment of
y_spring_w/12 inertia for Y spring
out-of-plane
bending
k3 4*12*EQ*I3/ 6400 N/m Spring constant for
y_spring_13"3 Y spring out-of-
plane bending
14 t_beam”3*tether_w/ 1.152E-21 m* Area moment of
12 inertia for tether
beam out-of-plane
bending
k4 4*12*EQ*14/ 5120 N/m Spring constant for
tether_1"3 tether beam out-of-
plane bending
GO 80[GPa] 8EIOQ Pa Shear modulus
k_th GO*t_beam* 8.0133E-7 Torsional spring
tether_w~3/ constant of tether
tether_1*(1/3- beam
0.21*tether_w/
t_beam*(1-
((tether_w/
t_beam)"4)/12))
k5 4*k_th/ 222.59 Jim? Spring constant
y_spring_13"2 from torsion of
tether beams
k_tot2 1/(1/k2+1/k3+1/k4+  178.35 N/m Total spring
1/k5) constant for out-
of-plane bending
f1 sqrt(k_tot2/m0)/2/ 45038 I/s Estimated sense

pi

mode frequency

The estimated sense mode frequency of 45 kHz is also not too far away from the

computed value of 41 kHz, especially given the complicated bending and twisting

configuration of the sense mode. Now we perform a prestressed frequency domain
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study to calculate the drive mode AC amplitude and the sense mode AC signal as a
function of the rotation speed. First enter the drive mode frequency from the previous
study result into the parameter table.

Parameters 5 - Result from Study 2
I In the Home toolbar, click FPi Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 5 - Result from Study 2
in the Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description

fd 38262[Hz] 38262 Hz Drive frequency (from computed
drive-mode eigenfrequency)

Then set up the prestressed frequency domain study. Note how the parameter AC_on is
used to turn on the AC drive in the second study step (Frequency Domain Perturbation).

ADD STUDY
I In the Home toolbar, click :\‘51 Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select

Preset Studies for Selected Physics Interfaces>Frequency Domain, Prestressed.
4 Click Add Study in the window toolbar.
5 In the Home toolbar, click :\‘j:i Add Study to close the Add Study window.

STUDY 3 - PRESTRESSED FREQUENCY DOMAIN
I In the Model Builder window, click Study 3.
2 In the Settings window for Study, type Study 3 - Prestressed Frequency Domain

in the Label text field.

Step [: Stationary
I In the Model Builder window, under Study 3 - Prestressed Frequency Domain click

Step |: Stationary.
2 In the Settings window for Stationary, locate the Study Settings section.

3 Select the Include geometric nonlinearity check box.

Step 2: Frequency-Domain Perturbation
I In the Model Builder window, click Step 2: Frequency-Domain Perturbation.
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2 In the Settings window for Frequency-Domain Perturbation, locate the Study Settings

section.
3 In the Frequencies text field, type fd.
4 Click to expand the Study Extensions scction. Select the Auxiliary sweep check box.
5 From the Sweep type list, choose All combinations.
6 Click | Add.
7 In the table, enter the following settings:
Parameter name Parameter value list Parameter unit
AC_on (I to turn on AC drive,0 1
otherwise)

8 Click |+ Add.

9 In the table, enter the following settings:

Parameter name Parameter value list Parameter unit

Omega (Angular rotation rate) 0 100 deg/s

10 In the Home toolbar, click = Compute.

RESULTS

Stress (solid) |
Create some plots to examine the result. First look at the drive mode amplitude.

I Right-click Results>Stress (solid) 1 and choose Duplicate.
Imag X displacement - Drive mode amplitude
I In the Model Builder window, under Results click Stress (solid) 1.1.

2 In the Settings window for 3D Plot Group, type Imag X displacement - Drive mode
amplitude in the Label text field.

Click to expand the Title section. From the Title type list, choose Manual.
In the Title text area, type Drive mode amplitude (um).

Locate the Plot Settings section. From the Frame list, choose Material (X, Y, Z).

o U1 AW

Locate the Color Legend section. Select the Show maximum and minimum values check

box.
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Volume |

I In the Model Builder window, expand the Imag X displacement - Drive mode amplitude
node, then click Volume 1.

2 In the Settings window for Volume, locate the Expression section.

3 In the Expression text field, type imag(u).

Deformation

I In the Model Builder window, expand the Volume | node, then click Deformation.
In the Settings window for Deformation, locate the Expression section.
In the x-component text ficld, type imag(u).

2
3
4 In the y-component text field, type imag(v).
5 In the z-component text field, type imag(w).
6

In the Imag X displacement - Drive mode amplitude toolbar, click Plot.

freq=38262 Hz, AC_on=1, Omega=100 deg/s Drive mode amplitude (um)

A 235

15

0.5

-0.5

-1.5

¥ -2.35

We see that the drive mode amplitude is about 2.4 um. This can be compared to an
estimation using an analytic formula. This gives a good estimate of 2.2 um (see
instructions below). The formula for the amplitude as a function of applied force, Q

factor, and spring constant can be found in standard textbooks such as Ref. 2 (Appendix
B).
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GLOBAL DEFINITIONS
Parameters 6 - Estimate drive mode amplitude
I In the Home toolbar, click Pi Parameters and choosec Add>Parameters.

2 In the Settings window for Parameters, type Parameters 6 - Estimate drive mode
amplitude in the Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description

n_overlaps 2*n_combs*4 64 Total number of comb
drive electrode
overlaps

F_comb_dc n_overlaps* 6.12E-6 N DC comb force

epsilonO_const*
t_beam*Vcomb~2/(2*

gap_combs)
F_comb_ac 2*F_comb_dc*V_ac/ 6.12E-7 N AC comb force
Vcomb
u_aco F_comb_ac*Q/k_tot 2.17E-6 m Estimated drive mode

AC amplitude

Create some plots to look at the sense mode response.

RESULTS

Stress (solid) |

In the Model Builder window, under Results right-click Stress (solid) | and choose Duplicate.
Real Z displacement - No rotation
I In the Model Builder window, under Results click Stress (solid) I.1.

2 In the Settings window for 3D Plot Group, type Real Z displacement - No rotation
in the Label text field.

3 Locate the Data section. From the Parameter value (Omega (deg/s)) list, choose 0.
4 Locate the Plot Settings section. From the Frame list, choose Material (X, Y, Z).
5 Locate the Color Legend section. Select the Show maximum and minimum values check

box.

Volume |
I In the Model Builder window, expand the Real Z displacement - No rotation node, then

click Volume 1.

2 In the Settings window for Volume, locate the Expression section.
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3 In the Expression text field, type w.

4 Clear the Compute differential check box.

Deformation

I In the Model Builder window, expand the Volume | node, then click Deformation.
2 In the Settings window for Deformation, locate the Expression section.

3 In the z-component text field, type w*1e3.

4 In the Real Z displacement - No rotation toolbar, click Plot.

Real Z displacement - No rotation

In the Model Builder window, under Results right-click Real Z displacement - No rotation and
choose Duplicate.

Real Z Displacement - Rotation
I In the Model Builder window, under Results click Real Z displacement - No rotation 1.

2 In the Settings window for 3D Plot Group, type Real Z Displacement - Rotationin
the Label text ficld.

3 Locate the Data section. From the Parameter value (Omega (deg/s)) list, choose 100.
4 In the Real Z Displacement - Rotation toolbar, click Plot.

5 Right-click Real Z Displacement - Rotation and choose Duplicate.

Real Z displacement - Net sense signal

I In the Model Builder window, under Results click Real Z Displacement - Rotation 1.

2 In the Settings window for 3D Plot Group, typc Real Z displacement - Net sense
signal in the Label text field.

3 Locate the Title section. From the Title type list, choose Manual.
4 In the Title text area, type Sense mode amplitude (um).
Volume |

I In the Model Builder window, expand the Real Z displacement - Net sense signal node,

then click Volume 1.
2 In the Settings window for Volume, locate the Expression section.
3 In the Expression text field, type w-withsol('sol4',w,setind(Omega,1)).
Deformation
I In the Model Builder window, expand the Volume I node, then click Deformation.
2 In the Settings window for Deformation, locate the Expression section.

3 In the x-component text field, type u-withsol('sol4',u,setind(Omega,1)).
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4 In the y-component text field, type v-withsol('sol4',v,setind(Omega,1)).
5 In the z-component text field, type (w-withsol('sol4',w,setind(Omega,1)))*1e3.

6 In the Real Z displacement - Net sense signal toolbar, click Plot.

freq=38262 Hz, AC_on=1, Omega=100 deg/s Sense mode amplitude (um)

A 3.36x10™
x10™

3

-3

¥ -3.36x107*

By clicking on the center of each proof mass in the plot and look at the result in the
Evaluation 3D table, we see that the sense mode amplitude is about 0.20 nm. This can
be compared to an estimation using an analytic formula. This gives a good estimate of
0.21 nm (see instructions below). The calculation of the Coriolis force can be found in
standard textbooks such as Ref. 2 (Chapter 22).

GLOBAL DEFINITIONS

Parameters 7 - Estimate sense mode amplitude

I In the Home toolbar, click Pi Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 7 - Estimate sense mode
amplitude in the Label text field.
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3 Locate the Parameters section. In the table, enter the following settings:

Name Expression Value Description
fs 41129[Hz] 41129 Hz Computed sense mode
eigenfrequency
k_from_fd mo* (2*pi*fd)~2 128.72 N/m Total spring
constant from
computed drive mode
frequency
u_ac0 from_f F_comb_ac*Q/ 23772E-6 m Drive mode AC
d k_from_fd amplitude from
computed frequency
v_ac0_from_f u_acO_from_fd*2* 0.5715 m/s Drive mode velocity
d pi*fd amplitude from
computed frequency
Fc 2%mO* 4.4431E-9 N Coriolis force
v_acO0_from_fd*
100[deg/s]
k_from_fs mo* (2*pi*fs)~2 148.74 N/m Spring constant from
computed sense mode
frequency
u_s_at_fs F_c*Q/k_from_fs 1.4936E-8 m Sense mode amplitude
if driven at sense
frequency
u_s u_s_at_fs/ 2.0651E-10 m Estimated sense mode
sqrt(1+Q~2*(fd/ amplitude at drive

fs-fs/fd)"2)

frequency

As an alternative to reading values off the graphs, in the following steps we show how to

use the Evaluation Group tool to evaluate the displacement values. First create an average

operator and update the solution so that the newly created operator will be recognized by

the solution dataset.

DEFINITIONS

Average | - Lower Electrodes

I In the Definitions toolbar, click (//// Nonlocal Couplings and choose Average.

2 In the Settings window for Average, type Average 1 - Lower Electrodes in the Label

text field.

3 In the Operator name text field, type aveoppp.

4 Locate the Source Selection section. From the Geometric entity level list, choose

Boundary.
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5 From the Selection list, choose Union 7 - Lower electrode effective region.

STUDY | - STATIONARY
In the Study toolbar, click (* Update Solution.

RESULTS

Evaluation Group | - Study | - Stationary
I In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, type Evaluation Group 1 - Study 1 -
Stationary in the Label text field.

Global Evaluation |

I Right-click Evaluation Group | - Study | - Stationary and choose Global Evaluation.

2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

Expression Unit Description

aveoppp (w) um Average Z displacement

4 In the Evaluation Group | - Study | - Stationary toolbar, click = Evaluate.

Continue to use the Evaluation Group tool to evaluate the drive mode and sense mode

amplitudes for the prestressed frequency domain study.

In addition, compute the sensitivity in terms of the sense capacitance change per rotation
rate, in the units of aF /(deg/s). Two alternatives are used below. The first one integrates
the capacitance per unit area variable C_A defined earlier over the effective region of the
lower electrodes. Note the use of the sign variable for the AC signal, and the use of the
Compute differential check box to evaluate the correct small signal amplitude of the variable
C_A, which is a nonlinear function of the dependent variables (alternatively, the 1indev
operator can be used with the check box cleared). The other one estimates the capacitance
change by taking the derivative of the analytic parallel plate capacitance with respect to the
gap size and multiplying by the sense mode amplitude. Both methods produced very
similar results. It can be useful to evaluate the sense capacitance amplitude without

dividing by the rotation rate, as shown in the last row of the global evaluation table.

STUDY 3 - PRESTRESSED FREQUENCY DOMAIN
In the Study toolbar, click /y Update Solution.
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RESULTS

Evaluation Group | - Study | - Stationary
In the Model Builder window, under Results right-click Evaluation Group | - Study | -
Stationary and choose Duplicate.

Evaluation Group 2 - Study 3 - Prestressed Frequency Domain
I In the Model Builder window, under Results click Evaluation Group | - Study | -
Stationary |I.

2 In the Settings window for Evaluation Group, type Evaluation Group 2 - Study 3 -
Prestressed Frequency Domain in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 3 -

Prestressed Frequency Domain/Solution 4 (sol4).
4 From the Parameter selection (Omega) list, choose Last.
Global Evaluation |

I In the Model Builder window, expand the Evaluation Group 2 - Study 3 -

Prestressed Frequency Domain node, then click Global Evaluation 1.
2 In the Settings window for Global Evaluation, locate the Expressions section.

3 In the table, enter the following settings:

Expression Unit Description
aveoppp(imag(sign*u)) um Drive mode amplitude
aveoppp(real(sign*w)) um Sense mode amplitude
intoppp(sign*C_A) /Omega/1[aF/ 1 Sensitivity (aF/(deg/s))
(deg/s)]

-aveoppp(real(sign*w))* 1 Estimated sensitivity

epsilon0_const*intoppp(1)/
t_anchor~2/0Omega/1[aF/(deg/s)]

intoppp(sign*C_A) aF Sense capacitance
amplitude

4 Seclect the Compute differential check box.

5 In the Evaluation Group 2 - Study 3 - Prestressed Frequency Domain toolbar, click
— Evaluate.
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